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NOTE: This guide contains details on options that may not be included with your 
PC. Your PC may look different from the illustrations in this guide. The monitor and 
the speakers are sold separately. Speakers may be included with the monitor 
(select models only). 

This section describes the PC by listing its internal and external components. It also 
gives you useful information on using the mouse, the keyboard, the monitor, 
speakers, a microphone, the media drives, and a printer. 

 

 
WARNING: Please read “Safety Information” in your user 
documentation before installing and connecting your PC to the 
electrical power system. 

 

PC Base Components 
The PC consists of electronics and mechanical items housed in a chassis box 
called a tower or base. Inside the PC are these items: 

• The motherboard, which is an electronics board with the micro processing 
unit (MPU), slots for memory and add-in cards, and connectors for the other 
items in the base. 

• The power supply. 
• The hard disk drive, which is used to store the operating system, programs, 

and files. 
• The cabling between the motherboard, the base units, and the connectors on 

the back and the front of the PC. 
 

Introducing the PC 
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PC Operation 
The user operates the PC by using a keyboard to enter text and commands, a 
mouse to point and select items, and a display monitor. For example, the PC 
shows the Windows desktop on the display screen, and when you move the 
mouse, the PC causes the cursor to move across the Windows desktop on the 
screen. 

The minimum items required to operate your personal computer are the PC base 
box, the keyboard, the mouse, and the monitor. 

Additional PC Base Components 
The PC base box may have other components, such as: 

• Optical drives that play or record (burn) CD or DVD discs, depending on the 
drive model. 

• A memory card reader that reads or records the memory cards used in digital 
cameras and other devices. 

• A diskette (floppy) drive. 
• A modem that connects the PC to a telephone line for a dial-up connection to 

the Internet. 
• An Ethernet connector that connects the PC to a network, such as a local area 

network (LAN). 
• Connectors and ports, such as USB, FireWire® (IEEE 1394), serial, parallel, 

and others, such as for a joystick. 
• Special features that may be on the motherboard or on separate add-in cards, 

such as audio or sound cards, graphics or video cards, TV connectors and 
tuner cards, and wireless LAN cards. 

 

External PC Components 
You may have external components added to the PC, connecting each to the PC 
base through the connectors on the front or the back of the base. The connectors 
on the front of the PC are usually used for quick, temporary connection. 
Depending on the connectors on your PC, common peripheral components are: 

• A printer (using a serial, parallel, or USB port). 
• An external disk drive. 
• A digital camera. 
• Video devices, such as a VCR, video camera, DVD player, or Web camera. 
• An MP3 player. 
• A personal organiser. 
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Protecting Your PC 

Using a Power Surge Suppressor 
Power surges, for example, voltage spikes, power outages or blackouts may cause 
software problems. 

Symptoms of voltage spikes include a flickering video display, unexpected PC 
startups and the PC not responding to your commands. A voltage spike can 
occasionally corrupt or destroy files. Because of this, you should: 

• Consistently make backup copies of your data files. 
And 

• Prevent damage from voltage spikes by installing a PC surge suppressor 
between the electrical socket and the PC powercable. 

 

Using Virus Protection Programs 
HP provides a virus-scanning software program to help protect your PC (select 
models only). 

A PC virus can destroy information on the hard disk drive. You can get a virus 
from infected files that you open from: 

• An e-mail message or attachment. 
• A file downloaded from the Internet. 
• A diskette (floppy disk). 
• A CD or DVD disc. 

 

Some viruses affect your PC immediately, while others may activate only if you 
open a certain file or do not delete the file before a certain date. New types of 
viruses are invented all the time. 

The virus-scanning software program on your PC has pre-set options that make 
your PC safe. After you enable the virus-scanning program, it checks your PC 
files for viruses. 

The virus-scanning program manufacturer provides free virus definition updates 
through your Internet connection for an initial period after your PC purchase. You 
can purchase a subscription service for updates after the initial free period 
expires. 

You should take the following precautions to protect your PC: 

• Do not open unsolicited e-mail from unknown sources. 
• Download files only from sources you feel are safe. 
• Always scan documents for viruses before opening them. 
• Make sure you have the latest version of your virus-scanning software. 
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Using Windows Update 
The Microsoft Windows XP operating system has a Windows Update software 
program that scans your PC, identifies necessary updates, and helps you to 
download them. Install critical updates to maintain your PC security and 
operation. 

To open Windows Update, click Start on the taskbar, click Help and Support, 
and then click Windows Update. Your PC must be connected to the Internet to 
display the Windows Update home page. Click Yes if you are prompted to install 
required software or controls. Click Scan for Available Updates, and follow 
the onscreen instructions. 

Turning Off the PC 
 

NOTE: For information about the Start button, see “Using the Start Menu” on 
page 23.  

 

For best results, turn off the PC using Windows without pressing any buttons on the 
PC chassis. 

1 Close any open software programs. To close programs, click the X at the 
upper-right corner of each program window. 

2 Click Start on the taskbar. 
3 Click Turn Off Computer, at the bottom of the menu. 
4 Click Turn Off. 
5 Turn off the monitor. 

 

As an alternative to turning off the PC, you can put the PC in either standby or 
hibernation mode. To conserve power, you can set the power management timers 
to put the PC automatically into standby, and then hibernation. See the following 
sections for more information on putting your PC in standby or hibernation mode. 

Standby Mode 
When the PC is in standby mode, it goes into a low-power state, and the monitor 
is blank, as if it is turned off. The advantages of using standby mode include: 

• You save time and electricity without having to wait for the PC to go through the 
normal startup routine when you wake it again. The next time you use the PC, 
any programs, folders and documents that were open before you put the PC in 
standby are available. 

• Your PC can receive faxes while in standby mode, if you set it to do so. 
• Your PC can retrieve e-mail messages and download information from the 

Internet automatically, if you set it to do so. 
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To put the PC in standby mode manually: 

1 Press the Standby button on the keyboard, if it is present. 
The screen goes dark, and the PC goes into standby mode. 

2 When you want to use the PC again, press the Esc key on the keyboard, or 
press the Standby button. The screen display reappears just as you left it. 

 

Another way to put the PC into standby mode is to: 

1 Click Start on the taskbar. 
2 Click Turn Off Computer. 
3 Click Stand By. 
4 To wake the PC from standby, press the Standby button or press the Esc key on 

the keyboard. 
 

If the PC does not work properly when you wake it from standby, restart the PC: 

1 Press and hold the On button on the front of the PC for approximately 
5 seconds until the PC turns off. 

 

NOTE: Using the On button to restart the PC is not recommended, and should 
be used only as a last resort. Instead, click Start, click Turn Off Computer, 
and then click Restart. 

 

2 Turn on the PC again. 
 

Hibernation Mode 
When the PC is in hibernation mode, it saves everything that is in PC memory to 
the hard disk drive, turns off the monitor and the hard disk drive, and then turns 
itself off. When you turn on the PC again, your programs, folders and documents 
are restored to the screen. 

To put the PC into hibernation manually: 

1 Click Start on the taskbar. 
2 Click Turn Off Computer. 
3 Press and hold down the Shift key on the keyboard, and then click Hibernate. 

NOTE: If Hibernate is not present, you can set up your PC for hibernation; refer 
to steps 1 to 6 of “Automatic Standby or Hibernation” on page 6. 

4 When you want to use the PC again after hibernation, press the On button on 
the front of the PC. 
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If the PC does not work properly when you wake it from hibernation, follow these 
steps to restart the PC: 

1 Click Start on the taskbar. 
2 Click Turn Off Computer. 
3 Click Restart. 

 

Automatic Standby or Hibernation 
You can set your PC to go into standby or hibernation mode automatically when it 
is idle for some number of minutes. To put the PC into standby or hibernation 
mode automatically, modify the power management settings: 

1 Click Start on the taskbar. 
2 Click Control Panel. 
3 Click Performance and Maintenance, if it is present. 
4 Double-click Power Options. 
5 Click the Hibernate tab and tick the hibernation feature. If necessary, enable 

the feature by clicking the Enable hibernation box so that a tick mark appears 
in it. 

6 If you changed the Enable hibernation tick box, click Apply. 
7 Click the Power Schemes tab to set the timers for standby and hibernation. 

In the Power Schemes box, select a power scheme from the drop-down list. 
Choose the settings. 
• To turn on automatic standby for the PC, click the time to elapse before 

standby (such as After 20 mins) in the System standby list. 
• To set the timer for automatic hibernation, click the time to elapse before 

hibernation (such as After 1 hour) in the System hibernates list. 

NOTE: If both standby and hibernation timers are set, the system hibernation 
timer must be set for a longer time than the system standby timer. 

8 Click OK. 
 

Restarting the PC 
When you restart the computer, the PC starts over using the operating system and 
software in its memory. This is the simplest repair for your PC; just click Start, 
choose Turn Off Computer, and then click Restart. 

You may wish to install additional software programs or hardware devices on 
your PC. Restart the PC after installation. 



 

Introducing the PC    7 

If the PC stops responding, use the Windows Task Manager to close any 
programs not responding or to restart the PC: 

1 Press the Ctrl, Alt, and Delete keys on the keyboard at the same time. 
2 Select the program that is not responding, and click End Task. 

Or 
Click Shut Down, and then click Restart. 

 

If this does not work, press the On button for 5 or more seconds to turn off the PC. 
Then, press the On button. 

 

NOTE: Using the On button to restart the PC is not recommended and should be 
used only as a last resort. Instead, click Start, click Turn Off Computer, and 
then click Restart. 

 

Using the Mouse 
Your PC includes a mouse for directing the cursor (pointer) on the Windows 
desktop. The mouse uses a roller ball or optics (a light and sensor) to sense 
movement and cause the cursor on the screen to move. Use the mouse on a 
flat surface. 

 

NOTE: The optical mouse cannot work on a glass, translucent or reflective surface. 

 

A wireless mouse (select models only) is an optical mouse that uses a 
receiver/transmitter, instead of a connector cable, to communicate with your PC. 
A light on the receiver indicates receiver activity. 

 

NOTE: The wireless mouse goes into a sleep or suspend mode after 20 minutes of 
inactivity. Click a button on the mouse to wake it. (Moving the wireless mouse 
does not wake it.) 

 

Using the Mouse Buttons 
The mouse has two or three buttons on the top: 

• Click the left mouse button to position the cursor or to select an item. 
• Click the right mouse button to display a menu of commands for the item 

you clicked. 
• On select models, use the scroll wheel button in the centre for scrolling 

and panning. 
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Click means to press the left button on the mouse once. 

Double-click means to press the left button on the mouse two 
times in a row. To double-click, you click the button (press it 
and then release it), and then quickly click it again. 

Right-click means to press the right button on the 
mouse once. 

To select an item, click the item.  

To select sequential items in a list or group, click the first 
item in the list, and then press and hold the Shift key on the 
keyboard while you click the last item. 

To select non-sequential items, click the first item, and then 
press and hold the Ctrl key on the keyboard while you click 
the additional items. 

 

NOTE: Your mouse may look different from the one shown here. 

 

You can switch the function of the left and right buttons for left-handed use. Refer 
to “Switching Mouse Button Functions” on page 9.  

Scrolling 
Click the left mouse button to place the cursor in a document, and then: 

• To scroll toward the beginning of a document, roll the scroll wheel button up 
(away from you). 

• To scroll toward the end of a document, roll the scroll wheel button down 
(toward you). 

 

Autoscrolling 
1 Place the cursor anywhere in the text, and press the scroll wheel button 

once. An autoscroll icon appears. 
2 Move the mouse in the direction you want to scroll. The farther you 

move the mouse from the starting point, the faster the document scrolls. 
3 To stop autoscrolling, press the scroll wheel button again. 

 

NOTE: Autoscrolling does not work with some software programs. 

A C
BA Left button 

B Scroll wheel button 
(scrolling mouse only) 

C Right button 
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Panning 
1 Press and hold down the centre scroll wheel button. 
2 Slowly move the mouse in the direction you want to pan. The farther you move 

the pointer from the starting point, the faster the document pans. 
3 To stop panning, release the scroll wheel button. 

 

NOTE: Panning only works if the window’s horizontal scroll bar is active. Panning 
does not work with some software programs. 

Switching Mouse Button Functions 
To switch the functions of the right and left mouse buttons: 

1 Click the Start button. 
2 Click Control Panel. 
3 Click Printers and Other Hardware, if it is present. 
4 Double-click Mouse. 
5 Tick Switch primary and secondary buttons on the Buttons tab. 
6 Click Apply (using the new primary button), and then click OK. 

 

Changing Mouse Pointer Speed 
To change the speed of the cursor on the screen relative to the motion of 
the mouse: 

1 Click the Start button. 
2 Click Control Panel. 
3 Click Printers and Other Hardware, if it is present. 
4 Double-click Mouse. 
5 Click the Pointer Options tab. 
6 In the Motion area, use the slider to adjust the pointer speed. 
7 Click Apply, and then click OK. 

 

Using the Keyboard 
The keyboard is the primary way you enter text and commands for the PC. The 
keyboard may connect directly to your PC, or it may be wireless. 

Your keyboard has an arrangement of standard keys, indicator lights and special 
buttons (select models only). Your keyboard may vary from the illustrations. Some 
keyboards do not have the Internet buttons shown here at the top of the keyboard, 
and some use a different layout on the top right. 
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Keyboard Shortcuts 
Keyboard shortcuts are combinations of keys that you press simultaneously to do 
specific actions. For example, from the Windows desktop, press the Alt (alternate) 
key, the Ctrl (control) key and the S key (the letter s), to display support 
information for the PC (including model number, serial number, and service ID). 
You will see this combination of keys represented as Alt+Ctrl+S. In Windows, 
press Ctrl+C to copy an item you’ve highlighted or selected, Ctrl+V to paste 
a copied item, or press Ctrl+Z to undo the previous action. These shortcuts 
perform the same actions you can perform through menus, but save you time 
and mouse clicks. 

Standard Keyboard Features 

Alphanumeric Keys 

 

The alphanumeric keys are the main keys found on a standard typewriter. 

Function Keys 

 

The function keys, located above the main keys, are labelled F1 to F12. 

• Pressing F1 displays a Help window for the software program being used. 
• Pressing F3 displays a search window. 

 

F1 and F3 are available at all times. 

Other function key operations vary by software program. 
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Edit Keys 

 

The edit keys are Insert, Home, Page Up, Delete, End, and Page Down. Use these 
keys to insert and delete text and to quickly move the cursor on your screen. They 
function differently with some software programs. 

Arrow Keys 

 

The arrow keys are controls for up, down, right, and left. You can use these keys 
instead of the mouse to move the cursor for navigation in a Web page, in a 
document, or in a game. 

Numeric Keys 

 

Press the Num Lock key to lock and unlock the numeric key functions: 

• When the Num Lock light on the keyboard is on, the numeric keys work in the 
same way as the number keys and arithmetic functions found on a basic 
calculator. 

• When the Num Lock light on the keyboard is off, the numeric keys are 
directional keys used to move the cursor or play games. 
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Keyboard Indicators 
Each keyboard indicator is a light labelled with the name or icon for its status: 

 

Icon Name Description 

 

Num Lock Numeric keys are locked as numbers keys and arithmetic 
functions. 

 
Caps Lock Alphanumeric keys are locked to uppercase. 

 
Scroll Lock Scroll function is locked. 

 

Special Keyboard Buttons 

 

There are special buttons (select models only) at the top of the keyboard. (Some 
models have some of these special buttons on the left side of the main keys.) These 
buttons operate a CD or DVD player, control speaker volume, connect you to the 
Internet, or provide quick access to specific functions. 

Volume Control 
The Volume knob increases speaker volume when turned clockwise, and 
decreases volume when turned anticlockwise. It can be turned indefinitely, even 
after maximum sound has been reached. 

The Volume Up  button increases volume, and the Volume Down  button 
decreases volume. 

The Mute button turns speaker sound on and off. 



 

Introducing the PC    13 

Media Control Keys 
 

b
c

da

a
e f

 

 

NOTE: The number, location, and labelling of buttons vary by keyboard model. 

 

Adjusting the Monitor 
To change the screen resolution: 

1 Right-click an empty area of the desktop and click Properties. 
2 On the Settings tab, adjust the screen resolution. 

• Moving the slide toward Less increases the size of text on your screen. 
• Moving the slide toward More decreases the size of text. 

3 Click Apply. 
4 Click Yes, if it is present. 
5 Click OK. 

 

NOTE: You can connect more than one display device (CRT monitor, flat panel 
monitor, TV, and so on) to the PC (select models only). You can quickly change 
where the PC desktop appears by pressing Alt+F5. Each time you press the Alt+F5 
key combination, the PC display appears on the next device. If Alt+F5 does not 
work, restart the PC and try again.  

 
a Open and close disc 

tray(s) 
b Record 
c Play or pause 
d Stop 
e Skip to the previous 

track 
f Skip to the next track 
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Using a TV as a Monitor 
Your PC may have TV-out (select models only) capability, which means you can 
connect it to a television to view the computer image on a TV screen. With the 
TV-out feature, you can view the computer image, watch DVD movies (if you have 
a DVD player), or play games using your TV. 

Cables You May Need 
To connect a TV to the PC, you may need a video cable and an audio cable 
(not provided; purchase separately). The type of video cable you need depends 
on your TV: 

• If your TV has an S-video socket, you need an S-video cable. 
• If your TV has a composite video socket, you need a composite video cable, 

and, depending on the sockets on the back of your PC, you may also need an 
S-video adapter cable. 

 

Viewing the PC Image on Your TV Screen 
The type of video card on your PC determines how the PC selects the TV-out 
option. 

When you want to disconnect the TV from your PC, you may need to disable the 
TV option to return your PC display to its original resolution. 

Using Speakers 
Speakers are included with the monitor (select models only), or are sold 
separately. For details on connecting stereo speakers to the PC, see the quick 
setup poster. 

 

NOTE: Speakers may be passive (no power button and no powercable) or active 
(power button or powercable). Your PC supports only active (powered) speaker 
systems; the speaker system must have its own powercable. 

A stereo speaker set is a left-right, two-channel speaker system. A multi-channel 
audio speaker system is a system with more than two channels, and it may include 
a subwoofer. For example, 5.1 channels, referred to as a six-speaker mode, uses 
two front speakers (left-right), two rear speakers (left-right), a centre speaker, and 
a subwoofer. 

 

If your PC has multi-channel audio speaker capacity (select models only), you can 
connect four channels for four speakers output or six channels for 5.1 speakers 
output. 

Connect your speaker system to the PC, and then configure the audio software for 
sound output. 
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Adjusting Speaker Volume 
Use the Volume icon on the taskbar to set speaker volume. Then you can 
adjust the volume using: 

• The Volume knob or buttons on the keyboard (select models only). 
• The Volume knob on the speakers (select models only). 

 

NOTE: If you do not see this Volume icon on the taskbar, click Start, choose 
Control Panel, click Sounds, Speech, and Audio Devices, if it is present, 
and then double-click Sounds and Audio Devices to open the Sounds and 
Audio Devices Properties window. On the Volume tab, place a tick in the Place 
volume icon in the taskbar tick box. Click Apply, and then click OK. The Volume 
icon appears in the taskbar. 

 

The two ways to use the Volume icon are: 

1 Click the Volume icon on the taskbar. 
2 Adjust the volume. 
3 When you are satisfied with the sound level, click outside the Volume window 

to close this window. 
Or 

1 Double-click the Volume icon on the taskbar. The Volume Control settings 
window opens. 

2 Adjust the volume. 
3 When you are satisfied with the sound level, click the Close box (the X in the 

upper-right corner) to close this window. 
 

Using a Microphone 
Your PC comes with one microphone connector in the back of the PC. Some 
models have a second microphone connector in the front of the PC. Only one 
microphone connector works at a time, and the back connector is ready to use 
unless you have the multi-channel audio speakers option. For PCs with the 
multi-channel audio speakers option, the microphone connector in the front of 
the PC, if present, is ready to use. 

To use a microphone connected to the front of your PC (select models only), select 
the working microphone. 

NOTE: If you connect your microphone to the back of your PC, you do not need to 
perform this procedure. 
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1 Double-click the Volume icon on the taskbar. The Volume Control settings 
window opens. 

 

NOTE: If you do not see this Volume icon, click Start, click Control Panel, 
click Sounds, Speech, and Audio Devices, if it is present, and then 
double-click Sounds and Audio Devices to open the Sounds and Audio 
Devices Properties window. On the Volume tab, place a tick in the Place 
volume icon in the taskbar tick box. Click Apply, and then click OK. The 
Volume icon appears in the taskbar. 

 

2 Select Options and click Properties. 
3 In Adjust volume for, click Recording. 
4 In Show the following volume controls, place a tick in the Microphone 

tick box. 
5 Click OK. 
6 Click the Advanced button in the Microphone column. If you do not see the 

Advanced button, select Options from the Recording Control window, and 
then click Advanced Controls. 

7 Place a tick in the Alternate Microphone tick box. (This box may be 
labelled Mic2 Select or 1 Mic Boost.) 

8 Click Close. 
9 Click the X (Close) at the upper-right corner of the Recording Control window. 

 

Adjusting Microphone Volume 
If you need to adjust the volume of the microphone, follow the procedure below: 

1 Double-click the Volume icon on the taskbar. The Volume Control 
window opens. 

2 Select Options and click Properties. 
3 In Adjust volume for, click Recording. 
4 In Show the following volume controls, place a tick in the Microphone 

tick box. 
5 Click OK. 
6 Adjust the volume for Microphone. If the volume is now acceptable, proceed 

directly to step 10. 
 

NOTE: If you do not see the Advanced button, select Options from the 
Recording Control window, and then click Advanced Controls. 

 

7 To make finer adjustments to the sound, click the Advanced button, and then 
select the (Microphone) 1 Mic Boost tick box. 

8 Click Close. 
9 Repeat step 6, if needed. 

10 Click the X (Close) at the upper-right corner of the Volume Control window. 
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Using Media Drives 

Using Your CD and DVD Drives 
Your PC can come with several types of CD or DVD drives that allow you to do 
different tasks. What you can do depends on what kind of drive you have. 

Allows you to: CD-ROM CD-RW DVD-ROM DVD+RW/+R 

Read data from CDs •  •  •  •  

Play music CDs •  •  •  •  

Read DVDs   •  •  

Record (burn) data or music 
to discs 

 •   •  

Play DVD movies   •  •  

Record (burn) DVD movies    •  
 

The combination (combo) drive is available on select models only. It combines the 
functions of two drives into one: either a DVD+RW/+R drive (dvd writer) and a 
CD-RW drive (cd writer), or a DVD-ROM drive and a CD-RW drive. 

Handling CDs and DVDs 
To avoid damaging a disc, follow these guidelines: 

• Return the disc to the case when you are finished using it. 
• Handle the disc by its outside edges or centre hole only. 
• Do not touch the unlabelled side of a disc or place the unlabelled side down on 

your desk. Doing so could scratch the surface of the disc. 
• Store discs at room temperature. 

 

Inserting and Removing CDs and DVDs 
 

 
CAUTION: Use only standard-shaped (circular) discs in your drives. 
Using non-standard discs, such as heart-shaped discs or business 
card discs, may damage your drive. 

 

To insert a CD or DVD: 

1 With your PC turned on, press the Eject button near the front of the drive to 
open the disc tray. 

 

NOTE: On some PCs, the drive is located behind a door on the front of the PC. 
 

2 Remove the CD or DVD from its case, holding the disc edges or centre 
hole only. 
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3 Gently place the disc in the tray with the label facing up. 
 

NOTE: On a double-sided DVD, read the text around the centre hole to 
determine which side (A versus B or Standard versus Widescreen) to play. 
Place the disc in the tray, with the label facing up for the side you want to play. 

 

4 Close the disc tray by: 

  

• Gently pushing the tray into the PC. 
Or 
• Clicking the open/close button on the control panel for the program that 

controls the drive. 
Or 
• Pressing the media control open/close button or Eject button on the 

keyboard (select models only). 
Or 
• Pressing the Eject button on the drive, if it is accessible. 

 

To remove a CD or DVD: 

1 With the PC turned on, open the disc tray by pressing the Eject button. 
2 Holding on to the disc edges or centre hole only, lift the CD or DVD out of 

the tray. 
3 Place the disc in its case. 
4 Close the disc tray by gently pushing the tray into the PC. 
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Using a Diskette (Floppy) Drive 
The diskette (floppy) drive is available on select model PCs. If your PC does not 
already have a diskette drive, you cannot add one to the PC chassis as an internal 
drive. Instead, purchase an external USB diskette drive or other external storage 
device to suit your needs. 

If your PC has a diskette drive (select models only), you can use a 3.5-inch diskette 
(floppy disk) to store files: 

1 Insert the diskette with the round metal disk facing down, and the arrow on the 
top pointing into the drive. 

2 Gently push the diskette into the drive until it locks in place. 
3 You can copy files from or to the diskette.  

 

 
CAUTION: Removing a diskette when the drive is reading from or 
writing to the diskette can damage the diskette or the information 
stored on it. 

 

4 When you are ready to remove the diskette, make sure that the light on the 
drive is off. When it is off, the PC is not reading from or writing to the diskette. 

5 Press the Eject button on the PC to remove the diskette. Remove the diskette 
from the drive prior to turning off the PC. 

 

Using a Printer 
Refer to the user manual that came with your printer for instructions on connecting 
and using the printer. 

Printers receive instructions from your PC via software called printer drivers. In 
many cases your PC automatically finds the printer driver necessary for the printer 
to work with your PC. If it does not, follow instructions that come with your printer 
to install the specific printer driver that it requires. 

You can print text and graphics from most software programs and Internet sites, if 
you have a printer connected to your PC and the necessary software installed for 
the printer. 

To print: 

1 Click File on the menu bar. 
2 Click Print. 
3 Select your printing options: 

• Select the printer. 
• Choose the page range (for example, all pages, current page, range of 

pages). 
• Determine the number of copies. 
• Select all, odd, or even pages in a range. 

4 Click OK. 
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The operation of your PC is controlled by two kinds of software: 

• The Microsoft Windows XP operating system, which displays the desktop 
on the monitor and controls your PC’s hardware, peripherals, and software 
applications. 

• Software programs that perform specific functions, such as a word processing 
program. 

 

Software programs included with the PC may vary by model and by 
country/region. 

Learning More about Software 
Information about using software and about the Microsoft Windows XP operating 
system is in the printed manuals and onscreen Help. The Microsoft Windows XP 
guide is included with your PC documentation. For Microsoft Windows, you can 
also press the Help button, labelled with a question mark icon on your keyboard 
(select models only), to open the built-in Help and Support Center, or you can click 
Start on the taskbar and then click Help and Support. For help with specific 
software, refer to the onscreen Help within the program. 

Using the Desktop 
The desktop is the work area that appears on the display monitor. It has the 
taskbar (along one edge), and shortcut icons that make it easy to find the things 
you need. 

The taskbar shows the Start button, a button for each open window so you can 
switch between programs, and the notification area that includes the time.  

A shortcut icon is a small picture that you click to open a folder or start a 
program. One icon on the desktop performs a special function; the Recycle Bin 
collects files that you delete. You can retrieve files from the Recycle Bin until you 
empty it. When you empty the Recycle Bin the files are permanently deleted. 

Introducing the Software 
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Removing Desktop Icons 
You can remove most desktop icons by either deleting them or moving them to an 
unused icons folder. 

 

 
CAUTION: Do not delete unfamiliar desktop icons. Instead, follow 
the steps to move unfamiliar desktop icons to the Unused Desktop 
Shortcuts folder. 

 

Delete a desktop icon by right-clicking the icon and then selecting Delete. 

To move a desktop icon to the Unused Desktop Shortcuts folder: 

1 Click Start. 
2 Click Control Panel. 
3 Click Appearance and Themes, if it is present. 
4 Double-click Display. 
5 On the Desktop tab, click Customise Desktop. 
6 Under Desktop cleanup, click Clean Desktop Now. 
7 Follow the onscreen instructions. 
8 Click OK to close the Desktop Items window, and click OK again to close the 

Display Properties window. 
 

Retrieving Desktop Icons 
Retrieve a desktop icon by opening the Unused Desktop Shortcuts folder on your 
desktop and dragging the icon onto the desktop. 
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Using the Start Menu 
Click the Start button to open the start menu and: 

• Select programs or documents. 
• Open the Help and Support Center. 
• Start a search. 
• Run a program. 
• Open the Control Panel to view or change settings. 

 

A

B C

D

 

 

The Start menu also displays the buttons Log Off and Turn Off Computer: 

• Click the Log Off button to end your current PC session and to switch between 
users. 

• Click the Turn Off Computer button to turn off the PC or to restart it. 
 

Using the All Programs Menu 
To find the software programs on your PC: 

1 Click Start. 
2 Choose All Programs. 

 

Organising Your All Programs List 
You see folders organised according to task (select models only) when you: 

1 Click Start. 
2 Choose All Programs. 

 

A folder contains a list of items. Each item is actually a shortcut, or link, to a 
program, a document or another folder. The Music folder, for example, contains 
shortcuts to the programs you use to play music CDs. 

To change the name of an item: 

1 Right-click the item. 
2 Select Rename. 
3 Type the new name, and press Enter on the keyboard. 
4 Click Yes in the message box. 

 

 
A Start button on the 

taskbar 
B Log Off button 
C Turn Off Computer 

button 
D All Programs 
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To move an item by using the drag-and-drop technique: 

1 Left-click an item in All Programs or in a folder, and hold down the mouse 
button. 

2 Move the mouse pointer to where you want the item, and then release the 
mouse button. 
(If you have problems dropping the item into a folder, drag it to your desktop, 
and then drag it to the folder.) 

 

To copy an item: 

1 Right-click the item. 
2 Select Create Shortcut. A copy of the item (shortcut) appears in the folder. 
3 Drag the item or the copy into the All Programs list or into another folder. 

 

If you use Add or Remove Programs in the Control Panel to delete a software 
program, the shortcut in All Programs may not be removed. To remove a shortcut: 

1 Click Start. 
2 Choose All Programs. 
3 Select the folder. 
4 Right-click the shortcut, and then select Delete. Click Delete Shortcut to 

confirm you want to delete the shortcut. 
 

Using the Control Panel 
The control panel is where you can set up or change properties and settings for 
the display, the keyboard, the mouse, the modem, a network connection and other 
components and features of the PC. The control panel also provides tools 
to change system performance, add hardware, add or remove programs and 
other tasks. 

To open the control panel, click Start on the taskbar, and then click 
Control Panel. 
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Resizing Windows 
All windows have some buttons in the upper-right corner. 

The middle button is either the Maximise button or the Restore 
Down button.  

 

Feature Name Description 

 

Minimise Collapses the window to the task bar (but does not close it). 
The window is still accessible. To bring the window back 
up, click the button with the name of the window on the 
task bar. 

 

Maximise Expands the window to the full screen. 

 

Restore Down Reduces the window from full-screen to covering a portion 
of the screen. 

 

Close Closes the window and stops the program or task. 

 

Resize Resizes a window (not available when window is 
maximised). Move your mouse cursor over any window 
border until the cursor becomes a double-headed arrow. 
Click and hold the left mouse button. Drag the border to the 
left or to the right to change the width. Drag the border up 
or down to change the height. 

 

Scroll bar A scroll bar appears on a window when the information 
does not fit on one screen. Clicking and dragging on a 
vertical scroll bar moves the screen up and down. Clicking 
and dragging on a horizontal scroll bar moves the screen 
left and right. 
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Working with Digital Images 
You can connect a digital image source, such as a digital camera or a digital 
video camera, directly to the PC or through a docking station. Digital picture 
files you copy or download from the device appear in the My Pictures folder. 
You can copy digital picture files from the memory cards, used by digital 
cameras and other digital imaging devices, by using the memory card reader 
(select models only). 

Digital cameras and other digital imaging devices use memory cards, or media, 
to store digital picture files. 
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A file is any unit of information that is named and stored on your PC hard disk 
drive or other electronic storage, such as a CD, floppy diskette, or even in a 
digital camera. A file can be an application program, a picture, music or 
sounds, a document or data. Almost everything you do on your PC involves 
working with files. 

The PC can copy files to other storage media within component drives, such as 
diskettes, memory cards, CDs or DVDs, or to output devices, such as a printer. 

Organising Files with Folders 
In Windows, folders make it possible for you to organise the files on your PC. 
Similar to paper folders within a filing cabinet, folders on your PC are a way to 
group related files together.  

A folder can contain any type of file and can even contain other folders. Each file 
within a folder must have a unique name, but two different folders can have files 
with the same name. 

There are two methods for working with the files and folders on your PC: 

• My Computer provides an easy-to-use view of the files and folders within a 
specific folder on your PC. It also has links to common tasks for managing your 
files, such as copying, moving, deleting and renaming. To open My Computer, 
click the Start button and then click My Computer. 

• Windows Explorer allows you to quickly see all the folders and files on your 
PC. It is easy to move or copy files from one folder to another in Windows 
Explorer. To open Windows Explorer, right-click the Start button and select 
Explore. 

 

To navigate around in the My Computer and Windows Explorer views, 
double-click folders to open and display their contents. Use the Back arrow 
button to retrace your path through the opened folders. 

Managing Files 
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Creating Folders 
Using My Computer: 

1 Click Start on the taskbar and click My Computer. 
2 Navigate to the location where you want the new folder. 
3 Under File and Folder Tasks, click Make a new folder. 
4 Type a name for the folder, and then press Enter. 

 

Using Windows Explorer: 

1 Right-click Start on the taskbar and click Explore. 
2 Navigate to the location where you want the new folder, and select the folder 

or device that will contain the new folder. For example, to create a new folder 
in the My Documents folder, you would select that folder.  

3 Click the File menu, select New, and then click Folder. 
4 Type a name for the folder, and then press Enter on your keyboard. 

 

Moving Files 
 

 
CAUTION: Moving any file that is part of an installed program can 
cause the program to be unusable. 

 

Using My Computer: 

1 Click Start on the taskbar, and then click My Computer. 
2 Find the file you want to move, and then select it by clicking the file. 
3 Click Move this file. 
4 In the Move Items window, click the folder where you want to put the file. 
5 Click Move. 

 

Using Windows Explorer: 

1 Right-click Start on the taskbar and click Explore. 
2 Find the file you want to move and select it by clicking the file. 
3 Click the Edit menu and click Cut. 
4 Find and open the folder where you want to put the file. 
5 Click the Edit menu and click Paste. 

 

NOTE: You can also move files by dragging and dropping them into a new 
location. Select an item in My Computer, or in Windows Explorer, and then press 
and hold the mouse button while moving the item to another folder. Release the 
mouse button to place the item in the new location.  
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Copying Files 
Using My Computer: 

1 Click Start on the taskbar and click My Computer. 
2 Find the file you want to copy and select it by clicking the file. 
3 Under File and Folder Tasks, click Copy this file. 
4 In the Copy Items window, open the folder where you want to put the file copy. 
5 Click Copy. 

 

Using Windows Explorer: 

1 Right-click Start on the taskbar and click Explore. 
2 Find the file you want to copy and select it by clicking the file. 
3 Click the Edit menu and click Copy. 
4 Find and open the folder where you want to put the file copy. 
5 Click the Edit menu and click Paste. 

 

NOTE: You can also copy files by dragging and dropping them into a new 
location. Select an item in My Computer, or in Windows Explorer, and then press 
and hold the right-mouse button while moving the item to another folder. Release 
the mouse button, and select Copy Here, to place the item in the new location.  

 

Finding Files 
1 Click Start on the taskbar and click Search. 
2 Under what do you want to search for?, click All files and folders. 
3 Under Search by any or all of the criteria below, type the name of the file or 

folder your want to find. 
 

NOTE: You can also search for files containing a specific word or phrase. 
 

4 Click the Look in drop-down menu and select where you want to search. 
 

NOTE: If you don’t select an area to search, the entire hard disk drive is 
searched. 

 

5 Click Search. 
The results of your search appear in the Search Results window. 
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Renaming Files 
1 Find the file you want to rename and select it by clicking the file. 
2 Click the File menu and click Rename. 

 

NOTE: Do not change the filename extension (the last three characters after the 
period in a filename). Changing the extension could make the file 
unrecognisable to the PC. 

 

3 Type the new filename and press Enter. 
 

NOTE: Another way to rename a file is to right-click the file and then click 
Rename. 

 

Deleting Files 
 

 
CAUTION: Do not delete any file that is part of an installed 
program. It can cause the program to be unusable. 

 

1 Find the file you want to delete and select it by clicking the file. 
2 Click the File menu and click Delete. 
3 Click Yes to confirm the delete and send the file to the Recycle Bin. 
If you make a mistake and need to get the deleted file back, see “Getting Files 
Out of the Recycle Bin.” 

NOTE: Another way to delete a file is to right-click the file and then click Delete. 

Getting Files Out of the Recycle Bin 
If you discover that you need a file that you have deleted, you can usually retrieve 
the file from the Recycle Bin. When a file is deleted, it goes to the Recycle Bin and 
stays there until the Recycle Bin is emptied or is cleared to make room for more 
recently deleted files. 

1 Double-click the Recycle Bin icon on your desktop. 
2 Find and click the file you want to retrieve. 
3 Click the File menu and click Restore. 

The file is removed from the Recycle Bin and goes back to its previous location. 
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This chapter describes connecting to the Internet, and using the Internet, including 
how to use a browser and e-mail. 

Use the Internet to search for and to find information or services on the Web, or to 
use an e-mail program to get, read or send electronic mail messages. 

Connecting to the Internet 
Hardware and software programs provided on your PC may vary. Your PC may 
come with: 

• A 56K modem and modem software (upgrade ready). 
• An Ethernet connector. 
• Special keyboard buttons to access the Internet. 
• The Internet Explorer Web browser program. 
• The Outlook Express e-mail software program. 

 

Connecting the Modem 
The modem is used for connecting to an ISP that provides telephone dial-up 
connection to the Internet. 

NOTE: Your PC may not come with a modem. 

Before you can connect to the Internet, and send or receive e-mail and faxes using 
telephone dial-up, you must connect your telephone service line to the modem (A), 
which is inside the PC (B). The setup poster shows you how to plug in a 
modem/telephone cable into the PC modem connector, and into your telephone 
line wall socket.  

A B

 

Using the Internet 

Other Ways to 
Connect 

There are other ways to 
connect to the ISP that 
do not use the telephone 
modem, such as a 
LAN (local area 
network) or DSL (digital 
subscriber line). Check 
with your ISP for 
specifics on your 
connection. 

 
A Modem connector 
B Back of PC 
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Setting Up the Ethernet Connection 
The Ethernet connection (may be called a network interface adapter, a Network 
Interface Card, or a NIC ) provides a high-speed, or broadband, connection to an 
Ethernet (10BaseT) or Fast Ethernet (100BaseT) network. After this interface is 
connected to a network, such as a LAN (local area network), you can connect to 
the Internet through the LAN. This network connection also allows you to share 
printers, data and other devices among your PCs. 

 

NOTE: Your PC may not come with an Ethernet connector. 

 

B

A  

With the PC turned on, check the lights (B) next to the Ethernet connector 
for status: 

• ACTIVITY — Lit yellow during network data transfer activity 
• LINK — Lit green with valid network connection 

 

About the Internet 
The Internet is a group of computers that communicate with each other through 
telephone lines, digital service, or cable lines. Each Internet computer is 
independent, and its operators choose which files to make available to users of 
the Internet. To connect your PC to the Internet, and use the information and 
services available there, you need an Internet Service Provider (ISP). 

ISPs are businesses that give you access to the Internet, and most of them provide 
electronic mail (e-mail) service. ISPs usually charge a monthly fee for their services. 
When your PC connects to the Internet, it is actually communicating with the ISP’s 
Internet computer. The ISP verifies your account and then provides you access to 
the Internet. You use a Web browser program to search, find and display Web 
site information. Some ISPs allow you to choose a browser program, while others 
provide their own browser. 

Your connection to an ISP may be through a traditional telephone dial-up modem, 
a LAN (local area network), cable modem, DSL (digital subscriber line) or ADSL 
(asymmetric digital subscriber line). (DSL, ADSL and cable ISPs are not available 
in all countries/regions.) 

A Ethernet connector 
(RJ-45 port) 

B Ethernet indicator 
lights 
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The World Wide Web (WWW), also called the Web, is a public part of the 
Internet used by individuals, companies, governments and organisations. These 
individuals and groups have created millions of Web pages in support of their 
activities. A Web page is a file or group of files that a user can access by 
entering the Web page’s file location, or URL. 

The URL (Uniform Resource Locator) identifies a Web site location, typically 
in the form http://www.name.extension (for example, http://www.hp.com). The 
URL may include the path to a specific file within that site. Each period, or dot, in 
the URL separates elements within the address. For example, you will see the URL 
extension .com used by companies. When you enter the URL into your browser 
address box, and press the Enter key on your keyboard, the browser contacts that 
location and displays the Web page for you. 

Imagine you are reading a newspaper. On page 1, you may read something like 
“For more details, see page 3, column 2.” You turn the page for more 
information. A hyperlink on a Web page works the same way, except that you 
click the mouse with your cursor over the link to move to the page or the Web site. 
The way that a hyperlink links files together is what gives the Web its name, 
because the Web weaves and connects idea to idea all over the world. 

Your e-mail address identifies the electronic post office box where people 
can send you electronic mail. E-mail addresses have the form 
name@domain.extension. The domain is usually the name of the ISP or 
organisation. The extension usually identifies the type of organisation. For 
example, if your name is Jane Jones, and XYZ is your ISP, your e-mail address 
might be JaneJones@xyz.com, with the extension .com indicating that XYZ is a 
business. For information on using e-mail, see “Sending and Receiving E-Mail” 
on page 35. 

Using a Browser 
A Web browser program searches for, finds and displays Web site information. 
How you explore the Internet depends on whether you are using an ISP that 
provides the browser or an ISP that allows you to use any browser. 

Once you are connected to the Internet, your browser displays the home Web 
page. You can go to a different Web site by entering its address (such as 
http://www.hp.com) in the address box in the Web browser and pressing Enter 
on your keyboard. Or you can use the browser Search tool to search for 
references to a specific word or phrase on the Web. 

mailto:name@domain.extension
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Searching the Internet 
Most browser programs include a search feature. You may need to click a button 
or select from a menu to display the search feature, depending on the type of 
browser program. Type a question or a word that describes the information you 
want to find into the Search box, and then press Enter. 

The Windows search feature includes direct use of the Internet Explorer Search. (If 
your ISP provides the browser, you may not be able to use Internet Explorer to 
search the Internet.) 

To begin a search: 

1 Click Start on the taskbar. 
2 Click Search. 
3 Click Search the Internet. (You may have to scroll down in the list to see 

this option.) 
4 Type a word or question into the Search box. 
5 Click Search. 

 

The PC connects to the Internet (if needed), performs the search and displays the 
results. Click a link in the results list to display the Web page. 

There are also Web sites specifically created for searching the Internet. These are 
called search engines. 

Restricting Internet Content 
The Internet provides you with a wide variety of information, but some information 
may not be suitable for every viewer. With Content Advisor (a feature of 
Windows XP), you can: 

• Control Internet access. 
• Set up a password. 
• Set up a list of Web sites that people who use your PC cannot view. 
• Adjust the type of content people can view with or without your permission. 

 

Once you set up restricted rating levels in Content Advisor, users can view Web 
sites and other pages that you have specified under the rating setup. However, to 
view unrated Web sites or pages, they must enter the Content Advisor password 
that you have set. This means that any unrated page, even Help and Support or 
Internet Explorer, is not viewable if the user doesn’t know the password. To allow 
access to an unrated site or page you approve of, open it and, when the 
password window appears, select the option always allow viewing or allow 
viewing only this time. 
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To use Content Advisor: 

1 Click Start on the taskbar, and then click Control Panel. 
2 Click Network and Internet Connections, if it is present. 
3 Double-click Internet Options. 
4 Click the Content tab. 
5 In the Content Advisor area, click Enable. 
6 On the Ratings tab, click a category in the list, and then click and drag the 

slider bar until the rating level is set to the limit you want to use. 
7 Repeat step 6 for each category you want to limit. 
8 Click Apply, and then click OK. 
9 Type a password into the Password box and the Confirm password box, and 

then click OK. 
 

NOTE: If you want to change the settings after the initial setup, click Settings in 
the Content Adviser area instead of Enable. The Enable button works as a toggle 
to turn the Content Advisor on and off. 

 

Sending and Receiving E-Mail 
E-mail (electronic mail) allows you to send and receive letters, pictures, postcards 
and even music and video clips. 

 

NOTE: E-mail may contain a virus in the e-mail message or as an attachment. To 
protect your PC, do not open any message from sources you do not know or that 
appears suspect to you. Instead, delete such messages. 

 

Your PC comes with an e-mail program from Microsoft called Outlook Express 
(select models only). You may also use e-mail programs from other vendors. Some 
ISPs provide their own e-mail programs. You use an e-mail program to send, 
receive and organise your messages. You can organise, read and create new 
messages even when you are off-line (not connected to the Internet). 

 

NOTE: Some models come with Microsoft Outlook instead of Outlook Express. For 
details on using Microsoft Outlook, open the Outlook program and select Help. 
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If Using Outlook Express 
The first time you start Outlook Express, the Internet Connection Wizard window 
opens if you are not already connected to the Internet. 

The Wizard will ask for connection information such as an account name and 
password and the names of an incoming and an outgoing mail server. If you need 
help with any of this information, contact your ISP. 

After the first time you sign up and connect through an ISP, you can run Outlook 
Express from the Start menu. 

Sending E-Mail Messages with Outlook Express 
1 Click Start on the taskbar, choose All Programs and select Outlook 

Express. 
 

NOTE: You can also press the E-Mail button on the keyboard to open Outlook 
Express (select models only). 

 

2 Click the Create Mail icon. 
3 Type in, or select from an address book, the address of each recipient. 

 

NOTE: E-mail addresses contain no spaces and have a period after the server 
name. Dashes and underscores are sometimes used. Capital letters may be 
required. 

 

4 Type your message in the New Message window. 
5 Type the message title in the Subject box. 
6 Click the Send button on the toolbar when you are finished. 
7 If necessary, click the Send/Recv tool on the toolbar to send any messages 

stored in the Outbox. 
 

NOTE: When you compose a message without being connected to the Internet, 
the message is stored in the Outbox until the next time you log on to the Internet 
and connect to your ISP. 
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Receiving E-Mail Messages with Outlook Express 
Your ISP receives e-mail messages for you automatically, even when your PC is 
turned off. The ISP then stores your messages until you connect to the Internet and 
open your e-mail program to read them. 

1 Start Outlook Express. 
2 If necessary, click the Send/Recv tool on the toolbar to have your e-mail 

program get the new messages from all listed e-mail accounts. 
3 Click the Inbox folder to view the list of incoming messages. Messages not yet 

read appear in bold on the screen. 
 

NOTE: In Outlook Express, the messages stay in your Inbox until you delete 
them or move them to another folder. 

 

4 Click a message once to view it, or double-click the message to expand it and 
read it in its own window. 

 

For more information about using your e-mail program go to the Help menu within 
the program. 

If Your ISP Provides the E-Mail Program 
Follow the ISP’s instructions to install its Web browser and e-mail program, and to 
set up and use your e-mail account. You will then be able to send and receive 
e-mail when your PC is connected to your ISP. 
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Over time, the availability of system resources on your PC can decrease, slowing 
down the performance of the PC. To improve the performance of your PC try: 

• Closing program windows; keep only one version of a program open at a time. 
• Restarting the PC; click Start, click Turn Off Computer, and then click 

Restart. 
• Increasing memory by adding or upgrading memory modules in the chassis. 
• Increasing available hard disk drive space. 
• Consolidating scattered files and folders on the hard disk drive. 
• Fixing hard disk drive errors. 

Increasing Available Hard Disk Drive 
Space 
Your PC comes with a hard disk drive with preloaded software programs, and 
a partition within the drive that takes up a certain amount of space on the hard 
disk drive. 

Viewing the Amount of Used and Free Disk Space 
1 Click Start on the taskbar. 
2 Click Control Panel. 
3 Click Performance and Maintenance, if it is present. 
4 Double-click Administrative Tools. 
5 Double-click Computer Management. The Computer Management window 

opens. 
6 Double-click Storage. 
7 Double-click Disk Management (Local). 

 

Information displays for each drive on your PC. You may need to scroll the 
window to the right to see the capacity and free space sizes. 
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Emptying the Recycle Bin 
When you delete a file from the hard disk drive, it goes to the Recycle Bin on your 
Windows desktop. You can retrieve files from the Recycle Bin until you empty it. 
When you empty the Recycle Bin, the files are permanently deleted. 

1 Double-click the Recycle Bin icon on your Windows desktop. 
2 On the File menu, click Empty Recycle Bin to delete all files. 
3 Click Yes to confirm the deletion. 

 

Uninstalling Programs 
 

 
CAUTION: Do not uninstall an unfamiliar program. If you need it, 
you may not be able to recover it using Application Recovery.  

 

1 Click Start. 
2 Click Control Panel. 
3 Double-click Add or Remove Programs. 
4 Click the Change or Remove Programs icon on the left of the screen, if it 

is not already selected. 
5 Select the program to uninstall. 
6 Click the Change/Remove button, and then follow the onscreen instructions. 

 

Cleaning Up Your Hard Disk Drive 
As you use your PC and store files, the hard disk drive fills up and becomes 
cluttered, affecting performance. To manage this, delete files you are not using. 

1 Close all open programs. 
2 Click Start on the taskbar. 
3 Click My Computer. 
4 Right-click the hard disk drive you want to clean, and click Properties. 
5 On the General tab, click Disk Cleanup. 
6 Wait for the calculations to complete. 

 

 
CAUTION: Do not delete unfamiliar files. If in doubt, do not delete. 

 

7 Select the types of files you want to delete, click OK, and then click Yes. 
8 Click OK to close the window. 
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Consolidating Scattered Files and Folders 
Over time, as you add, move and remove files and folders on your PC, the bits 
of data become scattered over the hard disk drive. This can slow down the 
performance of the PC. With the Disk Defragmenter program you can gather these 
bits of data together. This improves PC performance. Gathering your files and 
folders with the Disk Defragmenter does not affect the way you have them 
organised on your PC. 

 

NOTE: Using the Disk Defragmenter to gather the data on your PC may take a 
long time to complete. 

 

1 Close all programs running on your PC. This includes background programs, 
such as virus scanners. 

2 Click the Start menu, choose All Programs, choose Accessories, choose 
System Tools and then click Disk Defragmenter. 

3 Click Defragment. 
4 Follow the onscreen instructions. 

 

NOTE: If Disk Defragmenter starts itself over and over, this means a hidden 
background program is still running. To fix this issue, restart the PC and press F8 
on your keyboard as soon as the first logo screen appears. On the Windows 
Advanced Options menu, use the arrow keys to select Safe Mode and press 
Enter. Press Enter again to select the operating system. Log on to Windows. When 
the Desktop message appears, click Yes to continue in Safe Mode. After 
Windows starts up, use the steps above to start Disk Defragmenter. 
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Fixing Hard Disk Drive Errors 
The Microsoft ScanDisk program searches your hard disk drive for errors and is 
able to fix some errors. Fixing hard disk drive errors can improve PC 
performance. 

 

NOTE: Using ScanDisk to check for hard disk drive errors may take a long time to 
complete. 

 

1 Click the Start button and then click My Computer. 
2 Right-click the icon for the hard disk drive (usually labelled C:). 
3 Click Properties, and then click the Tools tab. 
4 Click Check Now. 
5 Place tick marks in all of the tick boxes. 
6 Click the Start button, and then click Yes to schedule a full disk scan for when 

the PC is restarted. 
7 Click OK. 
8 Click the Start button, click Turn Off Computer and then click Restart. 

ScanDisk starts as soon as the PC starts up again. 
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5.1 speakers, 14 

A 
adjusting microphone volume, 16 
adjusting speaker volume, 15 
ADSL (asymmetric digital subscriber 

line), 32 
All Programs menu, 23 
autoscrolling, mouse, 8 
available hard disk drive space 

increasing, 39 

B 
browsing the Internet, 34 
buttons 

mouse, 7 
mouse scroll wheel, 7 
Mute, 12 
Off. See turning off PC 
special keys, 12 
Start, 23 

C 
cables, for connecting a TV, 14 
CD 

keyboard button, 13 
chassis components, 1 
connecting 

a TV, 14 
Ethernet, 32 

Control Panel, 24 
opening, 23 

D 
desktop, 21 
desktop icons, removing, 22 
digital pictures, 26 
Disk Cleanup utility, 40 

disk space 
viewing, 39 

diskette 
inserting, 19 

diskette (floppy) drive, 19 
domain name, 33 
double-click, 8 
drag-and-drop 

copying items, 29 
move an item, 24 
moving items, 28 

DSL (digital subscriber line), 32 
DVD 

keyboard button, 13 

E 
e-mail 

address, 33 
defined, 33 
receiving, 35, 37 
sending, 35 
using Outlook Express, 36 

errors 
fixing hard disk drive, 42 

Ethernet 
about, 32 
connecting, 32 

F 
faxes, standby mode, 4 
file shortcut 

copy, 24 
delete, 24 

files 
consolidating, 41 

finding software programs, 23 

Index 
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floppy disk. See diskette 
floppy drive, 19 
free hard disk drive space 

viewing amount, 39 

H 
hard disk drive 

fixing errors, 42 
scan for errors, 42 

hard disk drive cleanup, 40 
hard disk drive space, increasing, 39 
hibernation mode, 5 

automatic, 6 
high-speed Internet connection, 32 
home Web page, 33 
hyperlink, defined, 33 

I 
indicators, keyboard, 12 
Internet 

about, 32 
browser programs, 33 
browsing the Web, 34 
connecting to, 31 
restricting content, 34 
searching the, 34 

Internet connection, high speed, 32 
Internet Service Provider (ISP), 

defined, 32 

K 
keyboard 

indicators, 12 
shortcuts, 10 
types of buttons, 12 
using, 9 

keyboard keys 
alphanumeric, 10 
arrow, 11 
edit, 11 
function keys, 10 
numeric, 11 

L 
logging off, 23 

M 
microphone 

adjusting volume, 16 
using, 15 

modem 
connecting, 31 
setting up, 31 

monitor 
changing resolution, 13 
changing where desktop displays, 13 
selecting, 13 

mouse 
autoscroll feature, 8 
buttons, 8 
double-click, 8 
left-handed, 9 
optical, 7 
panning feature, 9 
pointer speed, adjusting, 9 
scrolling, 8 
using, 7 
wireless, 7 

multi-channel speakers, 14 
Mute button, 12 

N 
Net. See Internet, about 
network interface 

about, 32 

O 
Off button. See turning off PC 
operating system, 21 
Outlook Express, 36 

receiving e-mail, 37 

P 
panning, scrolling mouse, 9 
PC 

chassis components, 1 
hibernation mode, automatic, 6 
improving performance, 39 
settings, 23 
sleep mode. See hibernation mode 
standby mode, about, 4 
standby mode, automatic, 6 
standby mode, manual, 4 
turning off, 4 

performance 
improving PC, 39 

pointer speed, adjusting, 9 
power management settings, 

modifying, 6 
printer 

using, 19 
programs, uninstalling, 40 
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R 
receiving e-mails, 35 
recording volume, adjusting 

microphone, 16 
recycle bin 

emptying, 40 
getting files out of the recycle bin, 30 

removing desktop icons, 22 
removing unneeded software, 40 
resizing a window, 25 
resolution, monitor, 13 
restricting Internet content, 34 

S 
saving electricity, 4, 5 
ScanDisk, 42 
scrolling mouse, 8 
searching 

for files or folders, 23 
the Internet, 34 

selecting programs or documents, 23 
sending an e-mail, 35 
settings 

viewing or changing, 23 
Volume Control, 15 

shortcut icons, 21 
shortcuts, keyboard, 10 
show Volume icon in taskbar, 15 
shutting down PC, 4 
sleep mode. See hibernation mode 
software 

finding, 23 
uninstalling, 40 

sound manager, multi-channel, 14 
speaker volume, adjusting, 15 
speakers, 14 

multi-channel, 14 
standby mode 

automatic, 6 
manual, 5 

Start button, 23 
Start menu contents, 23 
surface, using mouse on, 7 

T 
television, viewing PC image  

on a TV, 14 
turning off PC, 4 
TV 

connecting, 14 
TV-out, 14 

cables, 14 
disabling TV option, 14 

U 
uninstalling software, 40 
update Windows operating system, 4 
URL, defined, 33 

V 
virus protection, 3 
volume 

adjusting, 15 
adjusting microphone, 16 
controls, 12 
show Volume icon on taskbar, 15, 16 

Volume Control settings window, 15 

W 
Web. (See also Internet) 

browser programs, 33 
page, 33 
searching the, 34 

window, resizing, 25 
Windows Update, 4 
Windows XP, 21 
wireless mouse, 7 

 
 



 

 

 

 


